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1. Introduction 

This document is part of training modules for the Nile Basin Decision Support System 
(DSS). These modules are developed for use in classroom training that is given to 
Nile Basin countries and as a self-learning training material that will be made 
available as part of the DSS helpdesk and knowledgebase.   

1.1. Purpose 

The purpose of this document is to provide a tutorial on four modeling tools that are 
currently liked with NB DSS. The tutorial covers the following modeling tools:  

- MIKE HYDRO,  
- NAM,  
- MIKE 11 and  
- MIKE SHE 

All the above modeling tools are parts of Mike by DHI, registered trademark of DHI: 
Water – Environment – Health.  

1.2. Module pre-requisites 

The following prerequisites are needed before taking this tutorial: 
 
Software prerequisites: The MIKE by DHI version 2014 has to be installed. 
User prerequisites: User is expected to be familiar with the Rainfall-Runoff, 
catchment and hydrodynamics modeling basics and concepts. 

1.3. Expectations 

Upon successful completion of the lessons, exercises and review questions in this 
document, you will be familiar with the DHI modeling tools that can be used within the 
DSS.  

1.4. Conventions 

The following conventions are followed in this document: 

means a tip for the user 
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 means important information 

1.5. Module data 

Files that are needed for this module are located at the 
..\Modelling_Tools_Module\Data folder. 

1.6. Links to additional resources 

In addition to the information presented in this module, below are links to additional 
resources that you can access to obtain further information on the following: 

 MIKE By DHI products: 
 http://www.mikebydhi.com/products 

 MIKE HYDRO: 
 http://www.mikebydhi.com/products/mike-hydro-basin 
 MIKE HYDRO help file which can be accessed from MIKE Zero's help 

menu. 
 MIKE 11: 

 http://www.mikebydhi.com/products/mike-11 
 MIKE 11 help file which can be accessed from MIKE Zero's help menu. 

 MIKE SHE 
 http://www.mikebydhi.com/products/mike-she 
 MIKE SHE help file which can be accessed from MIKE Zero's help menu. 

1.7. Problem Reporting Instructions 

This document will be updated regularly. Therefore, it is highly recommended to 
report any spotted problem to helpdesk@nilebasin.org so it can be corrected in future 
versions. When reporting the problem, you are kindly requested to provide the 
following: 

 Document title 
 Document version 
 Page number where the problem was spotted 
 A description of the problem  
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2. Lessons 

In this section the following lessons (with exercises) are included: 
 MIKE HYDRO Tutorial: This lesson introduces you to MIKE Hydro and guides 

you through the set-up of a model and simulation of a simple catchment 
system.  

 NAM (Rainfall-Runoff model) Tutorial: This lesson introduces you to NAM and 
guides you through the set-up of a model and simulation of a simple Rainfall-
Runoff process.  

 MIKE 11 Tutorial: This lesson introduces you to MIKE 11 and guides you 
through the set-up of a model and simulation of a simple river system.  

 MIKE SHE Tutorial: This lesson introduces you to MIKE SHE and guides you 
through the set-up of a model and simulation of a catchment (rainfall-runoff) 
process.  
 
After completing the lessons and exercises in this section you will gain 
knowledge on using the DHI modeling tools that are available in the DSS.       
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2.1. MIKE HYDRO Tutorial 
Introduction 

MIKE HYDRO is the Graphical User Interface framework for some of the DHI Water 
resources software products. It features a map based and easy-to-use Graphical 
User Interface and will, in the coming releases, integrate the DHI Water resources 
products into one, common GUI framework. 

Short Description of MIKE HYDRO 

MIKE HYDRO offers a map based user interface for model building, parameter 
definition and results presentation for water resources related applications. MIKE 
HYDRO Release 2014 includes the following modules:  

 Basin module (MIKE HYDRO Basin) 
 River module (MIKE HYDRO River) 

 
MIKE HYDRO Basin is the successor of DHI's ‘MIKE BASIN’, former product for 
integrated water resources management and planning. It is a model framework for a 
large variety of applications concerning allocation, management and planning 
aspects of water resources within a river basin. Applications related to the MIKE 
HYDRO Basin module include: 

 Integrated Water Resources Management studies 
 Provision of multi-sector solution alternatives to water allocation and water 

shortage problems 
 Reservoir and hydropower operation optimization 
 Exploration of conjunctive use of groundwater and surface water 
 Irrigation scheme performance improvements  

 
MIKE HYDRO River is a modeling framework for defining and executing one-
dimensional river hydraulics models for a large variety of river related project 
applications. Release 2014 of MIKE by DHI is the first release including the MIKE 
HYDRO River module. This first release contains a subset of all required features 
and options which are available in the current User Interface framework for MIKE 11. 
Applications related to the MIKE HYDRO River module include: 

 Flood analysis and flood alleviation design studies 
 Real time flood or drought forecasting 
 Dam break analysis 
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 Optimization of reservoir and gate operations 
 Ecology and water quality assessments in rivers and wetlands 
 Water quality forecasting 
 Sediment transport and long term assessment of river morphology changes  
 Wetland restoration studies 

 
This tutorial focuses on the 'Basin' module of MIKE HYDRO. 

System Requirements 

The recommended minimum system requirements for MIKE HYDRO are: 
Operating 
systems 

Fully supported operating systems *  
Windows 7 Professional Service Pack 1 (32 and 64 bit), Windows 8 Pro (64 bit) 
and Windows Server 2008 R2 Standard Service Pack 1 (64 bit). Non-
supported but partially tested operating systems ** 
Windows XP Professional Service Pack 3 (32 bit), Windows 8 Pro (32 bit) and 
Windows Server 2012 Standard (64 bit).  

Processor 2.0 GHz Intel Pentium or higher and compatibles, or equivalents 
Memory (RAM) 2 GB (or higher) 
Hard disk 40 GB (or higher) 
Monitor SVGA, resolution 1024x768 in 16 bit colour 
Graphics adapter 64 MB RAM (256 MB RAM or higher recommended), 24 bit true colour 
Media DVD drive compatible with dual-layer DVDs is required for installation 
File system NTFS 
Software 
requirements 

.NET Framework 3.5 SP1 and .NET Framework 4.0 (Full Profile) 

* Fully supported operational systems are systems that have been tested in accordance with MIKE by DHI's Quality 
Assurance procedures and where warranty and software maintenance agreement conditions apply. 

** Non-supported but partially tested operating systems are systems, which are not officially supported by the MIKE 
by DHI software products. These operating systems have only undergone very limited testing for the purpose of 
MIKE by DHI software, but the software and key features are likely to work. Installation of MIKE by DHI software on a 
non-supported operating system is done so at the user's own risk.  

Installation of MIKE HYDRO 

Installation of MIKE HYDRO is done as part of the Mike by DHI installation (For 
details see the DSS installation training module). 

How to start MIKE HYDRO 

To start MIKE HYDRO, go to Start -> Programs -> MIKE by DHI 2014 -> MIKE Zero 
or search for MIKE by DHI 2014 and select ‘MIKE Zero’. Then you can select the 
drop-down menu ‘File’ and then select ‘new’ and select MIKEHYDRO and then follow 
the setup wizard (first time use). 
 
Starting MIKE HYDRO without a DHI configured hardware key and valid license files 
will cause the program to run in demo mode. If this happens, a message box will 
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inform you during program initialization. When running in demo mode, MIKE HYDRO 
supplies full access to all editors, computational engines and editing facilities. 
However, restrictions apply to the setups that can actually be executed as a model 
simulation or when saving the model file. 

MIKE HYDRO Interface 

The MIKE HYDRO User Interface consists of the following six main components 
(See Figure 1): 

 Tree view which contains three tabs:  
 Setup to control of model parameters 
 Symbology to control of symbology and labels 
 Results to view simulation results 

 Map view and tabular view which can be used to select and edit model 
objects respectively. 

 Property view which provides another way of displaying and editing the 
properties of model parameter groups, including the model objects.  

 Output window which can display a collection of different windows depending 
on the situation. By default, these windows are shown as tabs. The individual 
windows are: 
 Validation which shows validation status messages and error 

messages. Each time a model object is edited, its data is validated and 
any errors are shown in this window 

 Simulation which shows progress and output from the computational 
engine 

 Time Series which is automatically shown when plotting either input 
and output times series 

 Ribbon: This is located above the Map view and gives access to graphically 
editing the river network. Each model object will have a corresponding set of 
tools 

 Menu bar and tool bar which contains functionality for viewing and working 
with your model setup 
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Figure 1: MIKE HYDRO components 

 

MIKE HYDRO model objects 

In order to build a model in MIKE HYDRO, you need to use its objects to schematize 
your study area. Below is a description of the key MIKE HYDRO model objects that 
can be used in schematization.  

Catchment 
 
Catchments are primarily included in a model to provide inflow to the River network. 
A model may contain any number of Catchments. Catchments may be represented 
schematically, or by their delineated boundaries as illustrated in Figure 2. The 
primary difference between schematic and delineated catchments in a model setup is 
that the catchment surface area is directly derived from the topography used to 
delineate the catchment for the delineated ones whereas the surface area may be 
specified manually for the schematized catchments.  
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Runoff from Catchments can either be user-defined through a predefined runoff time 
series file or it can be calculated using one of several Rainfall runoff models available 
in MIKE HYDRO (e.g. NAM). Runoff from a Catchment is added to a River network at 
Catchment nodes.  
 

 
Figure 2: delineated catchment (left river branch) and schematized catchment (right river branch) 

River (links and nodes) 
The River network forms the basis of both Basin and River applications of Mike 
HYDRO. In the Basin application, the river network is defined as a combination of 
connected river branches with branch connections and River nodes as shown in . 

 
Figure 3: River network examples for a Basin model. 

Reservoirs 
 
The Basin module accommodates multiple multi-purpose Reservoir systems. 
Individual Reservoirs can simulate the performance of specified operating policies 
using associated operating rule curves. These define the desired storage volumes, 
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water levels and releases at any time as a function of current water level, the time of 
the year, demand for water, and losses and gains.  
 

Hydropower Plants 
 
The Basin module can perform advanced hydropower simulations for either existing 
systems or for evaluation of the feasibility of new developments. A Hydropower plant 
extracts water from one or more reservoirs, produces power according to effective 
head difference and power efficiencies, and returns water to one or more 
downstream locations. It is hence required to initially define at least one Reservoir in 
the model to be able to connect and include a hydro power plant within the model 
setup (illustrated in Figure 4). Calculation of hydropower can include special options 
such as conveyance and head losses as well as tail water level and backwater 
effects from cascading reservoirs 
 

 
Figure 4: Hydropower plant defined with a single reservoir connection and return flow definition to river 

location downstream of reservoir 

Water user Nodes 
Water users represent water consuming activities withdrawing water from the river or 
a reservoir. A model setup may contain any number of Water users of two types; 
Irrigation water users and Regular water user (e.g. municipal, industrial and any other 
type of Water user).  
 
Water users are connected to the river network through supply flow connections and 
return flow connections, where supply flow is being extracted from the supply 
connection point and the return flow is the water returned from the water user once 
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the final consumption has been calculated. Water user definitions and options for 
connections are illustrated in the figure below.  
 
  
 

 
Figure 5: Water users connected to the River network through Supply connections and Return flow 
connections  

Configuring a simple model in MIKE HYDRO 

This section describes the steps needed to set up a simple model in the Basin 
module.  

Create a new model 
To create a new model, start MIKE Zero, select ‘File’ then ‘New’ and choose the 
MIKE HYDRO model document type from the MIKE HYDRO group.  
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Figure 6: Create new MIKE HYDRO model 

 
Press the 'OK' button and an empty document will be created and the setup wizard 
will automatically open. Press the 'Next' button and move to the next step. 

 

Define simulation specifications 
The setup wizard guides you through the following simulation specifications:  
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 Modules 

The initial step to be made in a MIKE HYDRO model-file definition is to define 
whether the actual project is a Basin model or a River model. This selection is 
made in the upper drop down selection box. From this box, choose either 
'Basin' or 'River' to activate one of these model types.  
 
Following the selection of `Model type' there are a number of options for 
selecting additional features through activation of Model specific modules and 
global settings for the specific project (see Figure 7).  
 
  
 

 
Figure 7: Model type and Module selection page.  

The `Modules' section of this page contains two columns of checkboxes. 
These can be activated and deactivated by the user depending on the 
preferred GUI appearance and requirement for the project simulations. The 
checkbox functionality is as follows:  
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'Data' checkboxes: 
If the 'Data' checkbox is enabled, all data related to the specific module or 
feature will become visible in the user interface tree view and data may be 
edited.  
 
'Sim' checkboxes: 
To enable a specific module in the simulation, it is required to activate the 
'Sim' checkbox additionally. 
 
For this example, check the data and ‘sim.’ boxes for the basin simulation 
module which includes the options for calculating a large variety of different 
processes and model components taking part in the water consumption and 
influencing the water balance with a river basin. Press the 'Next' button and 
move to the next step. 
 

 Description: The Description dialog appears (Figure 8) and it includes the 
option for supplying a user specified 'Title' and a 'Description' for the 
simulation and the project in general. Every simulation should be given a Title 
to help in describing the actual simulation performed. The title is also included 
as part of the default name for result-files defined by MIKE HYDRO. Give 
your model a Title and description and then Press the 'Next' button to move to 
the next step. 
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Figure 8: Description dialog. 

 Coordinate System: The Coordinate System dialog appears (Figure 9). It is 
recommended to reference the model setup geographically. A coordinate 
system can be selected for the map as well as for the features (e.g. 
catchments, branches, and nodes with different types). If two different 
coordinate systems are selected, the coordinates of the features are 
automatically converted into the selected map coordinate system when 
displayed in MIKE HYDRO. However, features are saved in their own 
coordinate system in input and result-files. Since this is a demo example, 
select 'No projection' and press the 'Next' button and move to the next step. 
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Figure 9: Coordinate system dialog 

 Background Map: The Background Map dialog appears (Figure 10) to select 
map that can be used as background for your model. In this case select 
'None' and press the 'Next' button and move to the next step. 

 Shape File Overlay: The Shape File Overlay dialog appears (Figure 11Figure 

10). In order to add a shape file overlay click  and browse to select the 
shape file. If a projection file (PRJ file) exists, the projection type is 
automatically read. Otherwise, a user specified map projection must be 
selected. The shape file overlay can only be visible in Map view if the 'Overlay 
visible' option is enabled. Features may then be labeled by enabling the 
'Label features' option and selecting the desired Label field in the overview 
grid. Shape files are displayed in Map view following their order in the list of 
shape files, i.e. the shape in line 1 is plotted first, then shape 2 on top of 
shape 1, then shape 3 on top of shape 1 and 2 etc. It is possible to arrange 
the order of the different shape files by selecting a specific shape file and 
using the arrows ; to either move the specific shape file up or down in 
the list of shape files. Shape file overlays can be deleted using the  button. 
In this case leave the dialog as is and press the 'Next' button and move to the 
next step. 
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 Working Area: The Working Area dialog appears (Figure 12). A working area 
may be defined by clicking 'Draw working area as rectangle on the map' and 
dragging a rectangle on the map. Once defined, the working area may be 
edited (and edits must be saved) but it cannot be deleted (Figure 13). To 
show the working area in Map view, enable 'Show working rectangle on map'. 
If no working area is defined, the maximum extent of features is used as 
default working area. In this case define a suitable working area and save. 
Press 'Next' and then 'Finish' to close the wizard. 
 

 
Figure 10: Background map dialog 
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Figure 11: Shape File Overlay dialog 

 
Figure 12: Working area dialog  
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Figure 13: Editing and saving a working area 

 
Figure 14: Finish the wizard dialog 
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Create the River network 
After completing the simulation specification, model objects need to be added to the 
model. In this case, you will add first the branches of a river network including 
associated River nodes and Branch connections. These can be created in three 
different ways:  
 
Method 1: Digitizing a River network which is done using the Branches tools (will be 
described for this exercise).   
 
Method 2: Importing a River network from either an existing shape file or a MIKE 11 
network by selecting 'Import' option in the File drop-down menu as shown in Figure 
15.  

 
Figure 15: Importing a river network 

Method 3: Deriving the River network and its Catchments automatically from a Digital 
Elevation Model (DEM). In the current version the catchment delineation is only 
available for the Basin module. This is done by selecting the 'River tracing and 
catchment delineation' option in the 'Tool' drop down menu in the MIKE Zero menu 
bar.  
 

 
Figure 16: Deriving the River from a DEM. 

For the current exercise, you will digitize the river network on the map. For this 
example we have only one branch. To digitize a Branch, go to Map view, select the 
Branches ribbon and click on the 'Add' button (Figure 17). Use the left mouse button 
and click at each point along the river. To finish the Branch, double-click on the last 
point.  
To edit an existing branch, click on the ’Edit Branch' button and click on the branch to 
be edited. All points on the branch are shown with small squares (See Figure 18). To 
add a new point click on branch at the location of the new point. To move an existing 
point click on the square and drag to the new location. To remove an existing point 
double-click on the point. 
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Figure 17: Branch Ribbon 

 
Figure 18: An example of a branch in edit mode 

Branches may be connected by using the 'Add/Edit Branch Connection' button. In the 
Basin module, always digitize Branches and Connections from upstream to 
downstream.  
 
Your model should look like Figure 19 in the map view. 
 

 
Figure 19: River branch 
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In the setup tree view, select the Branches and then investigate the properties 
window (Figure 20). The river branch was given a name (i.e. Branch 1) which can be 
edited, an identifier and starts and end chainage which cannot be edited.    
 

 
Figure 20: Branch properties 

Create a Catchment 
In this example, the Catchment is a schematic catchment, i.e. the catchment is 
represented by a default shape. To create a schematic catchment, select the 'Add' 
button under the Catchments ribbon (See Figure 21) in Map view and clicking on the 
Branch at the downstream end of a catchment. The mouse cursor changes to a plus 
sign when it is on the branch. Here a catchment node will be automatically inserted. 
The upstream end of a catchment is given by the next upstream catchment node or 
the upstream end of the Branch. 
 

 
Figure 21: Catchment Ribbon 

Your model should look like Figure 22 in the map view. 
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Figure 22: River branch and a catchment 

When the catchment has been created, the catchment properties must be specified 
in the Catchments Tabular view or the Property view. Therefore you will see a red 
cross in the setup window (See Figure 23) and also validations messages (See 
Figure 24) to warn you about that. 
 

 
Figure 23: Red cross to warn that data is incomplete 

 
Figure 24: Catchment error messages in the 'Validation' window 

Go to the Tabular view, it should look like Figure 25. Since this catchment is 
schematized, you need to input its area. You need also to provide a runoff time 
series for it as you are not going to use a rainfall-runoff model in this case. So 
uncheck the 'Use catchment shape to calculate area' option and input an area of 100 
Km2. In the 'Runoff time series' box, click the  button then select 'Browse' and 
navigate to the ..\Modelling_Tools_Module\Data\MH folder and select the 'Catchment 
runoff time series_C1.dfs0' time series.  
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Figure 25: Tabular view for a catchment 

Insert a Reservoir 
 
To insert a Reservoir in the model select the 'Add' button under the Reservoirs ribbon 
(See Figure 26) in Map view and click on the desired location of the Reservoir. The 
Reservoir must be located on a river Branch. Move the mouse until the cursor 
changes to a plus sign – this signals that you found the branch where you can add 
the reservoir node. 
 

 
Figure 26: Reservoir Ribbon 

Your model should look like Figure 27 Figure 22in the map view. 
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Figure 27: Adding a reservoir to the model 

Now examine the 'Validation' window. A number of error messages appear in this 
window (Figure 28) after inserting the reservoir. They are all related to data that 
needs to be completed for it.  
 

 
Figure 28: Error messages in the 'Validation' window. 

Select the reservoir in the map view if it is not already selected by clicking on the 
'Select' option in the reservoir ribbon and then selecting the reservoir. This highlights 
the reservoir node and selects it in the properties pane. Move to the Tabular view to 
input the reservoir data (See Figure 29). You need first to select the reservoir type. 
There are three types of reservoirs can be modeled and the input requirements will 
depend on the reservoir type selected. These types are:  
 

 Rule curve reservoirs regard the reservoir as a single physical storage and all 
users are drawing water from the same storage. Operating rules for each user 
apply to that same storage and the users compete with each other to fulfill 
their water demand.  

 Allocation pool reservoirs also have physical storage, but the individual users 
have been allocated certain storage rights within a zone of water levels. An 
accounting procedure keeps track of the actual water storage in individual 
pools allocated for water supply users and in a single pool for downstream 
minimum flow releases (water quality pool). Thus, a particular water level is 
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not uniquely related to a set of volumes in all pools (one can 'shift' some 
volume from one pool to another without any effect on water level). 

 Lakes are specific reservoirs for which no operation rules apply. The outflow 
from a lake can be restricted by a spillway relationship. If no such relationship 
is given and the water level is at dead zone level (top of dead storage), all 
inflow that is not allocated to water users will flow out from the lake 
immediately. Lakes may be used to represent wetlands. 

 

 
Figure 29: Tabular view for a reservoir 

In this case, the reservoir is a 'Rule curve reservoir'. Now we need to enter a 'Level 
area volume curve' for this reservoir. In the 'Level area volume curve' box, click the 

 button then select 'Browse' and navigate to the 
..\Modelling_Tools_Module\Data\MH folder and select the 'Level area volume 
table_R5.dfs0' time series. Do the same for 'characteristic levels' and select the 
'Characteristic levels time series_R5.dfs0' time series. Now move to the next page 
'Operations' and do the same for 'Flood control level time series' and select the 
'Flood control time series file_R5.dfs0' time series.  Now go back to the 'General' 
page and change the initial water level to 544 m. All validation error messages 
should disappear now. 

Insert two Water users 
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To insert a Water user (regular and/or irrigation) in the model select the 'Add' button 
under the Water user ribbon (Figure 30) in Map view and click on the desired location 
of the Water user in the map. A Water user can extract water from one or several 
Branches and/or Reservoirs. This is done through a supply connection. A Water User 
can return unconsumed water to one or more Branches through return flow 
connections.  A connection can be added by selecting the 'Add' button under the 
water user ribbon in the map view by clicking on the starting point of the Connection 
and dragging to the desired end point.  The digitization of a connection must always 
be done in the direction of the flow, i.e. from extraction point to Water user, or from 
Water user to return flow point.  
 

 
Figure 30: Water users ribbon 

In this case, the following two water users will be added: 
1. A regular user that extracts water from the catchment node through a 

connection link and returns its unconsumed water to the branch. 
2. A regular user that extracts water from the reservoir node through a 

connection link and returns its unconsumed water to the branch. 
Your model should look like Figure 31 Figure 27Figure 22in the map view. 

 
Figure 31: Adding two water users 

Select the water user that extracts water from the catchment in the map view if it is 
not already selected by clicking on the 'Select' option in the water users ribbon and 
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then selecting the water user. Move to the Tabular view to input its data (See Figure 
32). You need first to input the user type. In this case ensure it is a regular user. 
 

 
Figure 32: Tabular view for a water user 

Now we need to enter a 'Water use time series' for this water user. In the 'Water use 
time series' box, click the  button then select 'Browse' and navigate to the 
..\Modelling_Tools_Module\Data\MH folder and select the 'Water use time 
series_W2.dfs0' time series. Now move to the next page 'Supply connections' and 
ensure the supply type is 'Call by priority'. Now move to the next page 'Return flow 
connections'. In this page, you need to specify the return from this user to the river 
branch (See Figure 33).   
 

 
Figure 33: Selecting return flow file. 
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Click the  button then select 'Browse' and navigate to the 
..\Modelling_Tools_Module\Data\MH folder and select the 'Return flow time 
series_E3.dfs0' time series. 
 
Repeat the same for the second water user node as follows: 

 Water user time series is 'Water use time series_W6.dfs0' 
 Supply type is 'Call by priority' 
 Return flow time series is 'Return flow time series_E7.dfs0' 

Insert a Hydropower plant 
To insert a Hydropower plant, select the 'Add' button under the Hydropower plant 
ribbon (Figure 34) in Map view and click on the desired location of the Hydropower 
plant in the map. The Hydropower plant needs to be connected to a reservoir. Its 
return flow connection is added by using the 'Add' Connection button under the 
Connection ribbon in Map view.  
 

 
Figure 34: Hydropower plants ribbon 

In this case, you need to add a hydropower plant that is connected to the reservoir 
and returns its flow to the same point the second water user does. Your model 
should look like Figure 35 Figure 27Figure 22in the map view. When drawing the 
connections, the cursor changes to a plus sign when over a reach, and changes to a 
circle with four edges when over a node (reservoir or hydropower plant). 
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Figure 35: Adding a hydropower plant. 

Select the hydropower plant in the map view if it is not already selected by clicking on 
the 'Select' option in the hydropower plant ribbon and then selecting the plant. Move 
to the Tabular view to input its data (See Figure 36).  
 

 
Figure 36: Hydropower plant tabular view 

Now we need to enter a 'Power demand time series' for this plant. In the 'Power 
demand time series' box, click the  button then select 'Browse' and navigate to 
the ..\Modelling_Tools_Module\Data\MH folder and select the 'Power demand time 
series_H7.dfs0' time series. Then check the 'Use Power efficiency table' box and in 
the 'Power efficiency table' box, click the  button then select 'Browse' and 
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navigate to the ..\Modelling_Tools_Module\Data\MH folder and select the 'Power 
efficiency table_H7.dfs0' time series. Then check the 'Use head loss table' box and in 
the 'Head loss table' box, click the  button then select 'Browse' and navigate to 
the ..\Modelling_Tools_Module\Data\MH folder and select the 'Head loss 
table_H7.dfs0' time series.    
Now before we move to next step, note that there are still two error messages in the 
'Validation' window. These are related to the reservoir as shown in Figure 37. They 
have been added after connecting the water user and the hydropower to the 
reservoir. The two messages mean that you need to add operating rules for 
supplying water to the individual users. This is done by specifying at least one 
reduction level & fraction rule for each user. A reduction level is a time series 
containing reservoir reduction water levels and their corresponding reduction factors.  

 
Figure 37: Reservoir validation messages 

When the reservoir water level falls below Reduction level 1 for a specific user, the 
actual extraction is calculated as the water demand times the specified Reduction 
factor 1. If the reservoir water level falls below Reduction level 2, a more drastic 
Reduction factor 2 is applied, and so on. Each user has its own set of reduction 
levels and corresponding reduction fractions and can have as many sets as required. 
Figure 37 illustrates how different Reduction levels and factors can apply to different 
water users. In the figure, a low priority user (e.g. industrial production) is getting its 
demand reduced earlier and more drastically, than a high priority water user (e.g. 
public water supply). Priorities are supplied as input properties of the users 
connected to the same reservoir (1 is the highest). 
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Figure 38: An example of reduction levels and reduction fractions for two users 

In the current exercise, specify the same reduction level for both users. To do this, 
select the reservoir as done in Insert a Reservoir section and open its tabular data 
window. Move to the 'Users' page (See Figure 39). Click in the box under the 'No. of 
Reduction levels' title and change the number to 1. Following that a new line will 
appear to allow you to add a reduction level time series (Figure 40). Click the  
button then select 'Browse' and navigate to the ..\Modelling_Tools_Module\Data\MH 
folder and select the 'Water supply fraction time series_E6.dfs0' time series. Repeat 
the same steps to add a reduction level time series for the hydropower plant. Now, 
you have completed configuring the model. From the 'File' menu click 'Save' to save 
the model. 

 
Figure 39: Changing the number of reduction levels 

 
Figure 40: Adding a reduction level and fraction time series 
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As noted, You can connect multiple Water users, Hydropower plants to a Reservoir. 
By default, connections are given a priority according to the sequence in which they 
are digitized. The priority can be changed in the priority column (See Figure 40). 
Number 1 has first priority; number 2 has second priority, and so forth. 

Validate the setup  
 
The initial validation status of the model setup is indicated in the Setup tree view. If a 
green tick mark is displayed on the tree node, the group of setup parameters is valid 
(See Figure 41). In case of errors, a red cross is displayed in the tree node and an 
error message is displayed in the Validation window.  

  
Figure 41: Setup window with tick marks - All green (Left) and an error (Right)  

In addition to this and before running the model, it is recommended to run an 
extended validation of the model setup. This is done by selecting 'Extended 
validation' in the 'Run' menu. Any validation issues will be shown in the 'Validation' 
window. In the current exercise, you should receive the message shown in Figure 42. 
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Figure 42: Successful extended validation 

Running a simulation 

Before running a simulation, you need to check the simulation period and the 
simulation time step. These can be checked from the 'Setup' window. Select the 
'Simulation period' under the 'Simulation specifications' as shown in Figure 43. In the 
'Properties' window, the simulation start and end appear. In this case leave the 
default values. 
 

 
Figure 43: Setting the simulation period 

To check the simulation time step, select the 'Time step control' under the 'Simulation 
specifications' as shown in Figure 44. In the 'Properties' window, the simulation time 
step length and units appear. In this case leave the default values. 
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Figure 44: Setting the simulation time step 

To execute the model engine, select 'Simulation' in the 'Run' menu. Outputs from the 
computational engine (i.e. status and error messages) are shown in the Simulation 
window (See Figure 45). 
  

 
Figure 45: Simulation status window 

Viewing the results 

When the simulation has been run, the results may be viewed in the Time series 
window. To add an output time series to the window, navigate to the relevant model 
parameter group in Results tree view, right click on the relevant object in the Property 
view and select the time series to be added to a new/current plot in the Time series 
window. Therefore, to show the hydropower generated at the hydropower plant follow 
the above steps as shown in Figure 46. Results are then shown in the time series 
window (Figure 47). Objects can also be selected in the map view and the context 
(right-click) menu will list all outputs for an object allowing plotting in a similar way. 
 

 
Figure 46: Viewing a time series output. 
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Figure 47: Time series window showing generated hydropower time series 

Further help 

For further MIKE HYDRO help, you are encouraged to use the help which is 
accessible by either pressing the 'F1' button on the keyboard or from the 'Help' menu 
then select 'Help topics'. For additional help, …   

Review Questions 

1. Describe the MIKE HYDRO modeling system. 
2. List some common applications of MIKE HYDRO Basin module. 
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Answers 

1. MIKE HYDRO offers a map based user interface for intuitive model building, 
parameter definition and results presentation for water resources related 
applications. MIKE HYDRO Release 2014 includes the following modules:  
 Basin module (MIKE HYDRO Basin) 
 River module (MIKE HYDRO River) 

 
MIKE HYDRO Basin is the successor of DHI's former product for integrated 
water resources management and planning 'MIKE BASIN'. It is a model 
framework for a large variety of applications concerning allocation, 
management and planning aspects of water resources within a river basin.  

 
2. Applications related to the MIKE HYDRO Basin module include: 

 Integrated Water Resources Management studies 
 Provision of multi-sector solution alternatives to water allocation and 

water shortage problems 
 Reservoir and hydropower operation optimization 
 Exploration of conjunctive use of groundwater and surface water 
 Irrigation scheme performance improvements   
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2.2. NAM (Rainfall-Runoff model) Tutorial 
Introduction 
NAM is a Danish  acronym for 'Nedbør-Afstrømings-Model' which means 
'Precipitation-Runoff-Model'. NAM is a rainfall-runoff module of MIKE HYDRO and 
MIKE 11 river modeling systems. It can be applied independently or used to calculate 
the runoff generated in one or more contributing catchments that generate lateral 
inflows to a river network. 

Short Description of NAM 

The NAM model is a deterministic, lumped (catchment is looked upon as a single unit 
with average values of parameters) and conceptual Rainfall-runoff model. It can 
present the processes that take place in the surface zone storage (Overland flow), 
root zone storage (Interflow) and the ground water storage (Base flow) as illustrated 
in Figure 48.  

 
Figure 48: Rainfall-runoff processes 

 
In addition, it contains provision to deal with snow melt and Irrigation schemes. 
Applications related to the NAM include: 

 Runoff forecasts 
 Extension of runoff series  
 Estimate effects of Climate Change, for instance on stream flow  
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This tutorial focuses on using the NAM module of MIKE HYDRO. 

System Requirements 

The recommended minimum system requirements for NAM are: 
Operating 
systems 

Fully supported operating systems *  
Windows 7 Professional Service Pack 1 (32 and 64 bit), Windows 8 Pro (64 bit) 
and Windows Server 2008 R2 Standard Service Pack 1 (64 bit). Non-
supported but partially tested operating systems ** 
Windows XP Professional Service Pack 3 (32 bit), Windows 8 Pro (32 bit) and 
Windows Server 2012 Standard (64 bit).  

Processor 2.0 GHz Intel Pentium or higher and compatibles, or equivalents 
Memory (RAM) 2 GB (or higher) 
Hard disk 40 GB (or higher) 
Monitor SVGA, resolution 1024x768 in 16 bit colour 
Graphics adapter 64 MB RAM (256 MB RAM or higher recommended), 24 bit true colour 
Media DVD drive compatible with dual-layer DVDs is required for installation 
File system NTFS 
Software 
requirements 

.NET Framework 3.5 SP1 and .NET Framework 4.0 (Full Profile) 

* Fully supported operational systems are systems that have been tested in accordance with MIKE by DHI's Quality 
Assurance procedures and where warranty and software maintenance agreement conditions apply. 

** Non-supported but partially tested operating systems are systems, which are not officially supported by the MIKE 
by DHI software products. These operating systems have only undergone very limited testing for the purpose of 
MIKE by DHI software, but the software and key features are likely to work. Installation of MIKE by DHI software on a 
non-supported operating system is done so at the user's own risk.  

Installation of NAM 

Installation of NAM is done as part of the Mike by DHI installation (For details see the 
DSS installation training module). It is not a stand-alone module. 

How to start NAM 

To start NAM  go to Start -> Programs -> MIKE by DHI 2014 -> MIKE Zero or search 
for MIKE by DHI 2014 and select ‘MIKE Zero’. Then you can start MIKE HYDRO as 
described in how to start MIKE HYDRO section. NAM is a rainfall-runoff module 
within MIKE HYDRO 
 
Starting MIKE HYDRO without a DHI configured hardware key and valid license files 
will cause the program to run in demo mode. If this happens, a message box will 
inform you during program initialization. When running in demo mode, MIKE HYDRO 
supplies full access to all editors, computational engines and editing facilities. 
However, restrictions apply to the setups that can actually be executed as a model 
simulation. 

NAM module EXERCISE – ATBARA BASIN 
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In this tutorial, a flow gauge in the Atbara river basin is used to help in building a 
lumped model of three catchments in the basin as shown in Figure 49. 
 

 
Figure 49: Atbara basin catchments and flow gauge 

  

Configuring a NAM model in MIKE HYDRO 

This section describes the steps needed to set up a NAM model for the above Atbara 
catchments.   

Create a NAM model 
To create a NAM model, start MIKE Zero and choose the MIKE HYDRO model 
document type from the MIKE HYDRO group. Follow the same steps as done in 
create a new model section but with the following changes: 

 Switch off the basin module and switch on the Rainfall Runoff module for data 
and Sim. 

 Give the model a title such as 'TA_NAM_Model' 
 Keep the defaults for the coordinate system, background map and shape 

overlay 
 In the working area, zoom in to the Atbara basin region and draw a working 

area rectangle. An example is given below in Figure 50.  
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Figure 50: Working area for the NAM model example 

Following the above steps, insert a river branch and catchment as done in the Create 
the River network and Create a Catchment sections under Mike Hydro within the 
working area as shown in Figure 51.    

 
Figure 51: NAM model with a river branch and a catchment 

Now the point at the catchment outlet represents the flow gauge point and the 
catchment represents the three catchments lumped into one. 

Defining the catchment parameters 
Select the catchments and move into its tabular view.  In the 'General' window, 
uncheck the 'Use catchment shape to calculate area' option and input an area of 
45608 Km2. This is the area of the three catchments. In the 'Rainfall-Runoff model' 
box select 'NAM' so the NAM model is used to calculate the run off. Tick also the 
'Calibration plot' option so you can specify observation data which can be plotted 
against simulation data. General data should look like Figure 52 after you finish.  
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Figure 52: General catchment data 

Next step is to specify the rainfall, evaporation and observed flow data of the 
catchments. This is done in the 'Rainfall-runoff' tab and then 'Time series' tab as 
shown in Figure 53.  

 
Figure 53: Adding time series data to a catchment 

In the 'Time series' window, you will input the following time series from the 
'..\Modelling_Tools_Module\Data\NAM' folder: 

 For Rainfall, select 'Rainfall.dfs0'.  
 For Evaporation, select 'PET.dfs0'. 
 For Observed flow, select ' Embamadre Discharge.dfs0'. 
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Calibration parameters and methods 

There are a number of parameters that you can calibrate to improve your NAM 
model. These parameters are: 

 Maximum water content in surface storage (Umax). 
 Maximum water content in root zone storage (Lmax) 
 Overland flow runoff coefficient (CQOF) 
 Time constant for interflow (CKIF) 
 Time constant 1 for routing overland flow (CK1) 
 Time constant 2 for routing overland flow (CK2) 
 Root zone threshold value for overland flow (TOF) 
 Root zone threshold value for interflow (TIF) 
 Root zone threshold value for groundwater recharge (TG) 
 Time constant for routing baseflow (CKBF) 
 Lower baseflow, recharge to lower reservoir (Cqlow) 
 Time constant for routing lower baseflow (Cklow). 

For a description of each one of those parameters please use the MIKE HYDRO 
help.  
 
MIKE HYDRO offers two calibration methods which are manual and automatic 
calibration. In manual calibration, you manually change the parameter values until 
you reach a good calibration.  In automatic calibration, you specify upper and lower 
bounds of a parameter, its initial value and the number of calibration runs. You need 
also to specify at least one objective function to use to achieve good calibration. The 
objective functions in MIKE HYDRO are:  
 

 Overall water balance. This defines the agreement between the average 
simulated and observed catchment runoff overall volume error. 

 Overall root mean squared error. This defines the overall agreement of the 
shape of the simulated hydrograph with the observed one. 

 Peak flow RMSE. This defines the agreement of simulated and observed 
peak flows events. If this measure is selected, the minimum river discharge 
value above which the flow is defined as peak flow has to be specified in the 
Peak flow box. 

 Low flow RMSE. This defines the agreement of simulated and observed low 
flows events. If this measure is selected, the maximum river discharge value 
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above which the flow is defined as peak flow has to be specified in the Low 
flow box. 
  
In this example, you will run with automatic calibration. To do this, go to the 
'Rainfall-runoff' and then 'Autocalibration' as shown in Figure 54. 

 
Figure 54: Selecting automatic calibration 

Ensure that 'Include autocalibration' is checked as shown in Figure 55. Leave the rest 
of the default values. 
 

 
Figure 55: Enabling the automatic calibration option 

Running a simulation 

Before running a simulation, make the following changes to the simulation period 
(See running a simulation section for information): 

 The simulation starts on 01/06/1967  
 The simulation ends on 31/12/1976. 

Following that, validate and run your simulation as done in validate the setup and 
running a simulation sections.  

Viewing the results 

Further help 
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For further help on NAM, you are encouraged to use the MIKE HYDRO help which is 
accessible by either pressing the 'F1' button on the keyboard or from the 'Help' menu 
then select 'Help topics'.    

Review Questions 

1. Describe the NAM module in MIKE HYDRO. 
2. List some common applications of NAM module in MIKE HYDRO. 
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Answers 

1. The NAM model is a deterministic, lumped (catchment is looked upon as a 
single unit with average values of parameters) and conceptual Rainfall-runoff 
model. It can present the processes that take place in the surface zone 
storage, root zone storage and the ground water storage. In addition, it 
contains provision to deal with snow melt and Irrigation schemes.  

2. Applications related to the NAM include: 
 Runoff forecasts 
 Extension of runoff series and data-quality assurance 
 Effects of Climate Change 
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2.3. MIKE 11 Tutorial 

Introduction 

The release of MIKE 11, back in 1997, started a new era for the most widely applied 
dynamic modeling tool for rivers and channels. MIKE 11 is part of the new generation 
of DHI software based on the MIKE Zero concept, comprising a fully Windows 
integrated Graphical User Interface, which conforms to the evolving standards for 
Windows based software with the well-known and well-tested computational core of 
the MIKE 11. 

Short Description of MIKE 11 

MIKE 11 is a professional engineering software package for the simulation of flows, 
water quality and sediment transport in estuaries, rivers, irrigation systems, channels 
and other water bodies. It is a one-dimensional modeling tool for the detailed 
analysis, design, management and operation of both simple and complex river and 
channel systems. With its flexibility, speed and user friendly environment, MIKE 11 
provides a complete and effective design environment for engineering, water 
resources, water quality management and planning applications. 
 
The Hydrodynamic (HD) module is the core of the MIKE 11 modeling system and 
forms the basis for most modules including Flood Forecasting, Advection-Dispersion, 
Water Quality and sediment transport modules. The MIKE 11 HD module solves the 
vertically integrated equations for the conservation of mass and momentum, i.e. the 
Saint Venant equations. 
 
Typical applications of MIKE 11 HD module include: 

 Flood forecasting and reservoir operation 
 Simulation of flood control measures 
 Operation of irrigation and surface drainage systems 
 Design of channel systems 
 Tidal and storm surge studies in rivers and estuaries 

 
The primary feature of the MIKE 11 modeling system is the integrated modular 
structure with a variety of add-on modules each simulating phenomenon related to 
river systems. 
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In addition to the HD module described above, MIKE 11 includes add-on modules 
for: 

 Hydrology (rainfall-runoff) 
 Advection-Dispersion 
 Models for various aspects of Water Quality 
 Sediment transport 

 
This tutorial focuses on the HD module of MIKE 11. 

System Requirements 

The recommended minimum system requirements for MIKE 11 are: 
Operating 
systems 

Fully supported operating systems *  
Windows 7 Professional Service Pack 1 (32 and 64 bit), Windows 8 Pro (64 bit) 
and Windows Server 2008 R2 Standard Service Pack 1 (64 bit). Non-
supported but partially tested operating systems ** 
Windows XP Professional Service Pack 3 (32 bit), Windows 8 Pro (32 bit) and 
Windows Server 2012 Standard (64 bit).  

Processor 2.0 GHz Intel Pentium or higher and compatibles, or equivalents 
Memory (RAM) 2 GB (or higher) 
Hard disk 40 GB (or higher) 
Monitor SVGA, resolution 1024x768 in 16 bit colour 
Graphics adapter 64 MB RAM (256 MB RAM or higher recommended), 24 bit true colour 
Media DVD drive compatible with dual-layer DVDs is required for installation 
File system NTFS 
Software 
requirements 

.NET Framework 3.5 SP1 and .NET Framework 4.0 (Full Profile) 

* Fully supported operational systems are systems that have been tested in accordance with MIKE by DHI's Quality 
Assurance procedures and where warranty and software maintenance agreement conditions apply. 

** Non-supported but partially tested operating systems are systems, which are not officially supported by the MIKE 
by DHI software products. These operating systems have only undergone very limited testing for the purpose of 
MIKE by DHI software, but the software and key features are likely to work. Installation of MIKE by DHI software on a 
non-supported operating system is done so at the user's own risk.  

Installation of MIKE 11 

Installation of MIKE 11 is done as part of the Mike by DHI installation (For details see 
the DSS installation training module). 

How to start MIKE 11 

To start MIKE 11, go to Start -> Programs -> MIKE by DHI 2014 -> MIKE Zero or 
search for MIKE by DHI 2014 and select ‘MIKE Zero’. Then you can select the drop-
down menu ‘File’ and then select ‘new’ and select MIKE 11 and then follow the setup 
wizard (first time use). See MIKE 11 Files for details. 
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Starting MIKE 11 without a DHI configured hardware key and valid license files will 
cause the program to run in demo mode. If this happens, a message box will inform 
you during program initialization. When running in demo mode, MIKE 11 supplies full 
access to all editors, computational engines and editing facilities. However, 
restrictions apply to the setups that can actually be executed as a model simulation.  
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Working with the MIKE 11 User Interface 

The current interface of MIKE 11, which is within MIKE ZERO, is different from MIKE 
HYDRO that was described in MIKE HYDRO Interface Section. When a MIKE 11 
model file is opened in MIKE ZERO, a window similar to the one shown in Figure 56 
appears. The Window has a number of elements such as menu and tool bars and 
buttons to perform a number of tasks such as creating, opening or deleting a project. 
It also has a window where recently opened projects can be quickly accessed. It also 
has a window where the model (or project) files are listed and it is called the 'Project 
Explorer'. This is where the files and folders that exist physically within the project 
folder are listed. Below the 'Project Explorer', a number of other tabs exist. These 
are: 

 File explorer where model related files are shown 
 Tools explorer where tools that are within MIKE ZERO can be accessed 
 Map explorer where a list project map related files are displayed (e.g. GIS 

layers) 
 

 
Figure 56: MIKE Zero Interface 

 MIKE 11 File types 
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MIKE 11 includes multiple editors each operating on different types of data. Data from 
these editors must be saved in separate editor files. The default MIKE 11 file 
extensions are listed below showing their corresponding editor. 
 

MIKE 11 Editor File Extension 
 Network editor *.NWK11 
 Cross-section editor *.XNS11 
 Boundary editor *.BND11 
 Time series files *.DFS0 
 HD parameter file *.HD11 
 AD parameter file *.AD11 
 WQ parameter file *.WQ11 
 ST parameter file *.ST11 
 FF parameter file *.FF11 
 Rainfall Runoff parameter file *.RR11 
 Simulation editor *.SIM11 
 Result files *.RES11 

 

MIKE 11 Files 
 

To create a new MIKE 11 simulation file, select 'File' from the MIKE ZERO main menu 
bar and choose 'New' and 'File...' to open the ‘New’ dialog (alternatively press Ctrl+N) 
as shown in Figure 57. 
 

 
Figure 57: ‘New File’ dialog for creating a new MIKE 11 simulation file 

Select the 'Mike11' node on the left and then 'Simulation (.sim11)' file type on the 
right and click OK. Following this, the simulation editor will be opened. 
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You can create other MIKE 11 files following the steps carried out to create a 
simulation file by selecting the type of file you wish to create and press the OK button. 
Following that, the specific editor of the created file will be opened (Figure 55).  
 

To open an existing editor file, select 'File' from the MIKE ZERO main menu bar and 
choose 'Open' and 'File...' to show the ‘Open file’ dialog (alternatively press Ctrl+O). 
Activate the file type combo box by clicking the arrow button in the ‘All Files (*.*)’ field 
and select the type of file you wish to open, see Figure 58. 
 

 
Figure 58: Open dialog including file MIKE 11 file types selection combo box 

 

After selection of the file, the corresponding editor will be automatically opened with 
the content of the selected editor file. The content of the loaded data file can now be 
modified. Upon termination of an input editing session, the editor file is saved by 
selecting 'File' then 'Save' from the main menu bar. You are automatically prompted 
to specify an editor filename if the file is newly created otherwise it is saved under its 
name if it is not new. 
 

It is essential that all input files are saved with the correct extension before a 
simulation is performed. (Example: saving a Network editor file with the name ‘TEST’, 
you should specify ‘TEST.NWK11’ to ensure, that all files holds the right extension as 
this is a must in order for the simulation part of MIKE 11 to work properly. 
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MIKE 11 Editors 
MIKE 11 comprises a number of different editors in which data can be added and 
edited independently of each other. In this section, a description of those editors is 
given. 
 

The Simulation Editor 
 
In MIKE 11, there is no direct linkage exists between its different editors as they are 
opened individually. Thus, it will not be possible to, for example, view the locations of 
cross-sections specified in the cross-section file in the network editor (Plan plot) if 
these editors are opened individually. The integration and exchange of information 
between each of the individual data editors is achieved by using the MIKE 11 
Simulation editor (See Figure 59).  
 

 
Figure 59: The Simulation Editor 

The Simulation Editor serves two purposes: 
 

 It contains simulation and computation control parameters and is used to start 
the simulation. 

 It provides a linkage between the graphical view of the network editor and the 
other MIKE 11 editors. Editing of cross-sections could be a typical example, 
where cross-sections can be selected from the graphical view in order to 
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open the cross-sections for editing in the cross-section editor. The linkage 
requires a file name to be specified for each of the editors. File names are 
specified on the Input Property Page of the simulation editor. 

 

Once the editor filenames are specified on the Input page, the information from each 
of the editors is automatically linked. You will be able to display and access all data 
from the individual editors (such as cross-sectional data, boundary conditions and 
different types of parameter file information) on the graphical view of the river 
network editor. 
 
Using the Simulation Editor 
 
The Simulation Editor combines all information necessary for MIKE 11 to perform a 
simulation. This information comprises type of model to run, name and location of 
input data files, simulation period, time step etc. and name of result files. It contains 
the following 5 property pages in which data must be specified:  
 

Models property page (Figure 60): To select the models (HD, AD, ST, WQ etc.) to be 
included by ticking the checkbox for the specific simulation model, additionally, you 
must select the simulation mode (Unsteady or Quasi steady simulation). If an 
encroachment simulation is to be made the encroachment checkbox must be 
checked. 
 

 
Figure 60: Models property page 
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Input property page (Figure 61): To specify the location of input files to be used in the 
simulation. The type of input files necessary for the simulation is identified by the 
colour of the edit fields. If the field is white the field can be edited and a file must be 
selected. If the field is grey (‘dimmed’) it is a non-editable field and the specific input 
file is not required for the simulation. One exception though, is the edit field; ‘RR 
Results (*.RR11)’ which is used to specify an input file from the Rainfall Runoff 
simulation only. If you do not require any runoff input from a Rainfall Runoff 
simulation, this field should just be left blank. Input files can be located in any 
directory on the disk. Use the  button to browse a specific input file in a file 
selection box; however, keeping them in one directory structure makes it easier for 
transferring the model from a machine to another and for quick selection. If a filename 

has been specified in a filename field, you can use the  button to open the file 
in its corresponding editor.  

 
Figure 61: Input property page 

 

Simulation property page(Figure 62): In the Simulation property page, information on 
the simulation period, time step and type of initial condition must be specified. 
Further the user can select if a fixed time step, a tabulated time step or an adaptive 
time step should be used. 
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Figure 62: Simulation property page 

There are two ways of specifying the simulation period: 
 Specify manually the simulation start and end time respectively.  

 

 Press the  button to let MIKE 11 automatically determine the 
minimum and maximum date and hour where all time series (defined in the 
boundary file) have common periods. The date and hour for start and end 
time respectively are then automatically inserted in the field. If no common 
period exists for the time series defined in the boundary files, nothing happens 
and the value in the Start and End date fields are not modified. 

 

After specifying the simulation period, the simulation time step must be defined. 
Specify a value for the time step and select the unit (days, hour, min, sec). 
 

The Time Step multiplier for Rainfall Runoff (RR) and Sediment Transport (ST) 
modules can also be specified in case one of these models is selected. The Time 
step multipliers are used to adjust the time step applied for these models. E.g. in ST- 
simulations it will often be necessary to run the Hydrodynamic model using a much 
smaller time step than required in the ST model. That is, the time step used in the 
RR and/or ST model is therefore the multiplier-value multiplied the simulation time 
step. Finally, specify the type of initial condition to use. These can be:  

 Steady State: MIKE 11 calculates automatically a steady state profile for the 
entire model, 
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 Hotstart: Initial conditions are read from results of previous simulation (define a 
result-file) 

 Parameter File: Initial conditions are read from Input Parameter file (e.g. HD 
Parameter file). 

 

Results property page(Figure 63): To specify the filename for results from the 
simulation. Storing frequency can be used to decrease the size of result-files by 
reducing the number of time steps saved. (e.g. Storing frequency specified as 10 
means that results are saved in the result-file for every 10 time-steps only). 
 

 
Figure 63: Results property page 

 

Start property page (Figure 64): In the Start property page you will find two validation 
groups. One group informing on the status of the simulation (are all input files 
required for the simulation specified? do the time series files used for boundary 
conditions have a common period – and is the simulation period within this period?).  
If a problem exists, a red light symbol is displayed in the validation group and it will 
not be possible to start the simulation. If all input files are satisfactory, a green light 
symbol is displayed and pressing the Start button starts the simulation. 
 
All information specified in the Simulation editor are saved in a Simulation editor file 
(*.sim11). The sim11 file is – as most of the other editor files in MIKE 11 – an ASCII 
text-file. It is therefore possible to view the content of these input files in any word 
processing program (e.g. Notepad). 
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Figure 64: Start property page 

 

The Network Editor 
The Network editor is a very central unit in the MIKE 11 Graphical User Interface. 
From the graphical view (the plan plot) of the network editor, it is possible to display 
information from all other data editors in MIKE 11. The Network editor consists of two 
views, a tabular view, where the river network data are presented in tables, and a 
graphical view, where graphical editing of the river network can be performed as well 
as data from other editors can be accessed. 
 

The main functions of the network editor are to: 
 Provide editing facilities for data defining the river network, such as 

- Digitization of points and connection of river branches, 
- Definition of weirs, culverts and other hydraulic structures, 
- Definition of catchments connecting the river model to a rainfall run-off 

model. 
 

 Provide an overview of all data included in the river model simulation which is 
provided via the possibility of presenting items from the different data editors 
on graphical view (e.g. location of cross sections or structures). The different 
items can be presented using symbols and lines of different color and size.  
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The tabular and the graphical view of the Network editor are shown in Figure 65. 
 

 
Figure 65: Network editor, Tabular and Graphical view 

 

The Cross-section Editor 
In MIKE 11, River cross-section data comprises two data sets, the raw and the 
processed data. The raw data (See Figure 66) describes the physical shape of a 
cross-section using (x, z) co-ordinates, typically obtained from a river bed survey. The 
processed data (See Figure 67) is calculated from the raw data and contains 
corresponding values for level, cross-section area, flow width, hydraulic/resistance 
radius. The processed data table is used in the computational module. Each cross 
section in MIKE 11  is uniquely identified by the following: 

 River name: String of any length. 
 Topo ID: String of any length. (topographical identification) 
 Chainage: Real number showing the cross section distance from the most 

upstream point of a branch. 
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Figure 66: Cross-Section Editor, Raw Data View 

 
Figure 67: Cross-Section Editor - Processed Data View. 

 
 

The Boundary Editors 
Boundary conditions in MIKE 11 are defined using the 'Boundary Editors' which 
comprise the 'Time series editor' and the 'Boundary editor'. Both editors are 
necessary to activate in order to specify a MIKE 11 boundary condition. 
 
A boundary condition is defined by the combined use of time series data prepared in 
the ' Time Series editor' and specifications made on locations of boundary points and 
boundary types in the 'Boundary editor'. 
 
 



DSS Modeling tools 

 Page 64 

Time series editor 
The appearance of the Time series editor differs if you create a new (blank) time 
series compared to opening an existing file. 
 
Creating a new time series requires specification of properties for the time series file. 
Therefore, the File Properties dialog is therefore opened in this case. If you are 
opening an existing file, the data are immediately presented in the Time series data 
dialog where data can be viewed and edited both in a graphic and a tabular view.  
 
 

File Properties dialog 
 
To open a Time series File , select 'File' from the MIKE ZERO main menu bar and 
choose 'New' and 'File...' then select the 'MIKE ZERO' node and then 'Time Series 
(.dfs0)' icon as shown in then click 'OK' (See Figure 68).   
 

 
Figure 68: Creating a new time series 

Following that, the 'New Time Series' Dialog appears, select 'Blank Time Series' and 
click 'OK' (See Figure 69). This brings the 'File properties' dialog where you define 
the time series properties (See Figure 70).  
 

The Time series file has an extension 'dsf0' and it can have more than one time 
series. 
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Figure 69: New Time Series Dialog 

 
Figure 70: Time Series Editor, File properties dialog 

 
 
Time Series data dialog 
To view exiting 'dfs0' files, the time series data dialog is used (See Figure 71). It 
consists of two views, a tabular view and a graphical view.  
 
The Tabular view presents the time series data in tabular form allowing data entry. In 
the Graphical view, data can also be edited graphically by selecting one of the editing 
modes; 'Select, Move, Insert or Delete available from the context (right-click) menu. 
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Figure 71: Time series editor; Time series data dialog 

 
Boundary editor 
The boundary editor dialog is where boundary conditions are specified for 
hydrodynamic, advection-dispersion/water quality and sediment transport 
calculations. The boundary editor is shown in Figure 72. 
 

 
Figure 72: Boundary editor 

 
The definition of a Boundary condition requires the following actions to be performed 
in the order as listed: 
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 Specify the boundary description (e.g. open, point source) and type (e.g. 
water level, Inflow). These can be selected from a drop down menu by 
pressing the arrow at right side of the field. 

 Specify location which is defined by the river name (again from a drop down 
box) and the chainage which is typed.  

 Once the above is defined, the data associated with this boundary needs to be 
defined. This done in the time series box at the bottom of the 'Boundary edior'   

 

The Parameter File Editors 
The MIKE 11 parameter file editors are comprised of the Hydrodynamic, Advection-
Dispersion, Water Quality, Sediment Transport and Rainfall Runoff editors. The 
Parameter editors contain information on variables related to the selected type of 
computation, e.g. the HD Parameter Editor contains information on the bed 
resistance as a significant variable for the hydraulic computations. 
 

All parameter editors are designed as dialogs containing a number of property pages 
in which specific data can be entered. Clicking the corresponding ‘tab’ in the editor 
dialog will activate a property page. In this Tutorial, we will focus on the HD 
parameter editor.  
 
HD parameter editor 
To run a hydrodynamic computation it is required to create a HD Parameter file. The 
HD parameter editor offers a possibility of specifying user-defined values for a number 
of variables used during the hydrodynamic computation. The HD parameter editor is 
shown in Figure 73. It has the following tabs: 
 
Initial: Where you specify the initial conditions 
 

Wind: where you include Wind shear stress in the HD calculation if you wish. it is 
required that a time variable boundary condition for Wind Field are included in the 
simulation. The Wind Field boundary condition consists of specifications for Wind 
direction (towards North) and the Wind velocity. 
 
Bed Resistance: Where bed resistance must be specified in this page.  
 
Bed Resistance Toolbox: Where you a possibility to make the program calculate the 
bed resistance as a function of the hydraulic parameters during the computation by 
applying a Bed Resistance Equation. 
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Wave Approx: Where you specify if wave approximation should be used in the 
computation (e.g. Kinematic, Diffusive or one of two fully dynamic wave 
approximations). 
 
Default Values: Where it is possible to alter the value for a number of parameters 
connected to the hydrodynamic computations. Parameters should not be altered, 
unless you are familiar with the effect on the results. A more detailed explanation of 
the various parameters is given in the MIKE 11 On-line help system and MIKE 11 
Technical Reference manual. 
 

 
Figure 73: HD Parameter Editor 

 

Quasi Steady: Where a number of Quasi-Steady Control parameters connected with 
the Quasi steady computations are entered in this page. Detailed description can be 
found in the MIKE 11 On-line Help and MIKE 11 Technical Reference manual. 
 
Reach Lengths: This can only be used in connection with Quasi Steady simulations. 
Detailed description can be found in the MIKE 11 On-line Help and MIKE 11 User 
manual. 
 

Add. Output: Where additional output can be produced upon request by the user. This 
extra facility is available as a supplement to the hydrodynamic default result file. The 
additional output is stored in a file with a similar name as the HD result-file name. 
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Only difference is that an additional string ‘HDADD’ is added to the filename of the 
HD result-file name. Example: if the HD result filename is ‘HDRES1.RES11’, the 
name of the additional output file would be; ‘HDRES1HDADD.RES11’ 
 

Flood Plain Resistance: Normally, the resistance numbers on flood plains are included 
through editing the relative resistance factors in the Cross-section editor, Raw data 
specifications. Hence, it is possible to reduce the effective flow area as a function of 
the water level. Another possibility of changing flood plain resistance numbers is to 
edit the Resistance Factor in the Processed Data in the cross-section editor. 
 

However, if the modeling task does not require a water level dependent resistance on 
flood plains, an overall Flood Plain Resistance number can be specified in this page. 
 

User Def. Marks: The User Defined Markers page offers you a possibility to define 
items in the modeling area, which you would like to present on a longitudinal profile 
(e.g. gauging stations, bridges etc.). Markers can be defined as single points at a 
specific chainage or as a marker with a certain length between two chainages in the 
same river stretch. 
 

Encroachment: The Encroachment module of Mike 11 can be used to make analysis 
of the effect on making encroachment on floodplains. The necessary information is 
specified on this property page. Details can be found in the MIKE 11 On-line Help and 
MIKE 11 User manual. 
 

Heat Balance: It is possible to include detailed descriptions of the heat exchange 
between the water and the atmosphere in Mike 11. The necessary data must be 
entered here. Details can be found in the MIKE 11 On-line Help and MIKE 11 User 
manual. 
 

Stratification: When one or more of the branches in the Mike11 set up have been 
selected as ‘Stratified’ the data necessary to run the stratified model must be entered 
here. Details can be found in the MIKE 11 On-line Help and MIKE 11 User manual. 
 
Time Series output: Were extra time series output files are generated during the 
simulation. This output is in addition to the regular and the additional output file. Time 
series output can be saved in .dfs0 or ASCII files. Time series output files are 
typically requested instead of manually extracting time series data in selected grid 
points from the regular and the additional output files after the simulation has been 
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completed. This is often useful for automatic or manual calibration or when running 
many simulations. 
 

Maps: Where you may produce two dimensional maps based on the one dimensional 
simulations. The maps are made as rectangular grids and constructed through 
interpolation in space of the grid point results. Thus the maps constructed in this way 
should be viewed as a two dimensional interpretation of results from a one -
dimensional model.  
 
Groundwater leakage: The Groundwater Leakage page defines leakage coefficients 
such that an additional loss of water from the river (to the groundwater) can be 
included in the simulation. 
 

  



DSS Modeling tools 

 Page 71 
 

Configuring a simple model in MIKE 11 

In this tutorial, you will be guided through the set-up of a simple river network, cross-
sections, boundary conditions, HD parameters and simulation parameters as well as 
presentation of simulation results. 
 

Network Editor – Basic functions 
The aim of this exercise is to introduce the basic functions of the network editor, i.e. 
how a system of branches is defined and connected. 
 

Start MIKE Zero to bring up the MIKE Zero start screen. The MIKE 11 river network 
file is created here using the 'File' menu and selecting New from the menu (See the 
MIKE 11 Files section for details). A MIKE 11 river network screen is created with 
default area co-ordinates. The size and position of both the MIKE 11 window and the 
river network window may be changed to allow easier viewing of river branches 
defined later in this tutorial. 
 

Defining a branch 
Defining and editing a river network is mainly undertaken using the river network 
toolbar. More details on the functionality of each of the buttons can be found in the 
MIKE 11 On-line Help. 
 

 
Figure 74: River Network toolbar 

 

To define the branch shown below in Figure 75, select the  button in the toolbar 
and define the branch by clicking the left mouse button once at the position of each 
river point. Start at the upstream end of the river branch (which is assumed here, to 
be in the upper part of the window). The last point in the branch should be defined by 
a double click. 
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Figure 75: Plan plot, one digitized branch 

 

Chainage in points 
Once a branch is defined the chainage of each point is calculated automatically based 
on the distance between the digitized points. The default chainage of the first point in 
a branch is zero. The calculated chainages may not be optimal and the user may wish 
to set the chainage manually. This can be done in two ways: 
 

 Right click at the point for which the chainage is to be changed and a Pop-Up 
Menu will be displayed as shown in Figure 76. When selecting the item Point 
Properties in the Pop-Up Menu the following dialog will show up (See Figure 
77). You can then set the chainage manually by setting the chainage type to 
User Defined and then entering the desired chainage value. When clicking the 
OK button the chainages in all remaining points within the river branch will be 
recalculated accordingly. 
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Figure 76: Network editor, Right mouse Pop-up menu 

 
 

 
Figure 77: Point properties dialog 

2) Select the Tabular View in the 'View' menu and change to the Points page of the 
tabular view as shown in Figure 78. This page contains information about each point 
and allows the user to change the chainage type and value. The graphical and tabular 
views are linked such that the highlighted points in the each of the views are always 
the same. 
 
In the above river system the chainage type should be set to user defined for the first 
and last points of the river branch with the chainage assumed to be 2 and 100000, 
respectively. 
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Figure 78:  Graphical and Tabular view, Network editor 

 

Display of objects 
To control the appearance of the graphical view, the Network Settings dialog shown 
in Figure 79 can be used. This dialog is activated by selecting the Network in the 
'Settings' menu. The left hand side of the page presents the graphical object 
possible to present on the graphical view organized in a tree structure. Each object in 
the tree-view has an entry for defining individual settings for points, lines, labels etc. 
Open settings for editing a specific object by opening the tree-view and highlight the 
object you wish to edit. Selecting an object allows for changes in the right hand side 
of the dialog.  The 'Display' tick-box determinates whether the specific object will be 
presented in the Graphical view (in case the object is present in the network file 
presently edited). Additionally, it is possible to switch on or off the display of all items 
in an entire branch of the tree-view (Network, Boundary, Hydro Dynamic Parameters, 
etc) by using the right mouse button on a branch.  
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Figure 79: Network settings dialog 

 

Defining and connecting additional branches 
The  tool can be used to create the points and branch in one operation. 
Alternatively the points can be defined in one operation and the branch in another by 

using the  tool followed by one of the tools  or . 

In Figure 80, eight points in a tributary have been digitized using the  tool. Note 
that the points appear in the list of points in the tabular view, but there is yet no 
information on which branch the points belongs to. 
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Figure 80: One branch defined, second branch digitized 

 

To connect the eight points the tool  or  can be used (start at the left most 
point; drag the mouse with left button)) and when the connection is done the screen 
should look similar to Figure 81. 
 

Note that the branch information is now available in the list of points in the tabular 
view. The chainage type should be set to user defined in the first and last point and 
the chainages set to 12000 and 27000, respectively. 
 

Before connecting the two branches each should be given identification names. This 
is done on the branch page of the tabular view where the river names are changed to 
Main and Trib as shown Figure 82. For both rivers the Topo ID should be set to 
1997. 
 

To connect the tributary to the main river, the  button should be used. Point at the 
downstream end of the tributary and while clicking and holding the left mouse button 
move the cursor to the point on the main branch you wish to connect and then 
release the mouse button. The connection is indicated by a line as shown in Figure 
83. 
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Figure 81: Two branches defined with user-defined chainages in up- and downstream points 

 
Figure 82:  River Names defined as ‘Main’ and ‘Trib’ 
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Figure 83: Connection of river branches 

 
The contents of the network editor should now be saved by selecting the Save item in 
the 'File' menu. 
 

Cross-section Editor 
The aim of this section is to show how cross-sections are created and then to 
establish links between the network editor, the cross-section editor and other editors. 
 
In the simulation editor file names for both the network and cross-section files are 
required, and to do so an empty cross-section file needs to be created and saved 
(‘File’  ‘New’  ‘Cross-section’). This is done as shown in the MIKE 11 Files 
section. Similarly an empty simulation file has to be also created and saved. 
 
The simulation file is loaded and on the Input page of the simulation file editor the 
name of the network file and the empty cross-section file is specified using the  
button (See Figure 59) under the 'Network and 'Cross Section' boxes respectively. 
The network file can now be accessed using the Edit button on the simulation file 
menu. 
 
Cross-sections are required to be inserted at upstream and downstream end of both 
branches. This is done using the Pup-Up Menu. Point at the upstream end of the 
Main branch and click at the right mouse button and select 'Insert', 'Network' and  
'Cross-section' as shown in Figure 84.  
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Figure 84: Using the Right mouse pop-up menu to insert new cross-section 

The cross-section editor will appear and the data for the cross-section can be entered 
as shown in Figure 85. The name of the branch and the chainage will be 
automatically transferred to the cross-section editor. 
 

 
Figure 85: Cross-section editor, raw data editor 
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Once the raw data has been entered the button 'View Processed Data' should be 
pressed to display the processed data tables (See Figure 86). The processed data 
will be calculated when the 'Recompute' button is pressed. 
 

 
Figure 86: Cross-section editor, Processed data editor 

 
Identical  cross-sections should now be inserted at the downstream end of Main 
branch and at both ends of Trib branches. 
 
The cross-section file can be now saved and closed. 
 

Boundary and Time Series Editor 
The aim of this section is to create time series and boundary conditions. 
 
The boundary condition at the upstream ends is zero discharge and at the 
downstream end the water level varies between 5 and 6 meters. First the file 
containing the variation in time of the water level and the discharge must be defined 
and to do so a new time series file is created from as described in the Boundary 
Editors section. The properties for the file should be entered as in Figure 87. 
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Figure 87: Time series ‘File Properties’ dialog 

 

The format of the start time follows the standard windows format, which might be 
different from the above in Figure 87, depending on the configuration of your PC . 
Once the OK button is pressed the time variation of the water level can be entered as 
Figure 88. The discharge values are to be kept as zeroes. 
 

The content of the time series editor should be saved and closed using the File menu. 
An empty boundary file must now be created (See the MIKE 11 Files section for 
details). The name of the file should be specified on the Input page of the simulation 
editor. 
 
The location and type of boundaries can now be specified through the network editor 
where the Pop-Up Menu is used to insert the boundary at the downstream end of 
Main. The boundary editor now pops up and the location of the boundary is 
automatically transferred as shown in Figure 89. 
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Figure 88: Time series editor, two items included in time series file 

 

 
Figure 89: Boundary editor, defining downstream boundary condition 

 

The time series file must be specified using the Browse button and afterwards the 
correct item can be selected in the time series file. This is done using the Items 
button, which starts the item selector as in Figure 90.  
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Figure 90: Time series, Item selector dialog. 

 

In a similar manner the discharge boundaries at the upstream of both Main and Trib 
must be inserted and the correct file and item has to be selected. The boundary 
editor should now have content as in Figure 91. 
 

 
Figure 91: Boundary conditions. 
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The content of the boundary editor can now be saved and the editor closed using the 
'File' menu. 

HD Parameter Editor 
The final data required to run a simulation is the HD parameters, and to define those 
a HD Parameter File is created through the 'File' menu (See the MIKE 11 Files 
section for details). The only parameters to be changed from the default values are 
initial conditions. This is specified on the left most page of the HD Parameter file as 
shown in Figure 92. The initial water level should be 5 meters and initial flow is 0 
m3/s. 
 

 
Figure 92: HD Parameter file, Initial conditions 

 
The contents of the file should be saved and the name of the file should be specified 
on the input page of the simulation editor. 
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Running a Simulation 

In order to run the simulation the pages of the simulation editor must be set-up as 
shown in the following figures. 
 

 
Figure 93: Simulation editor, Models selection page 

 

 
Figure 94: Simulation editor, selection of input files for simulation 
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Figure 95: Simulation period, time step and initial condition selection for simulation 

 

 
Figure 96: Specify the result-file name 
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Figure 97: Ready to start the simulation – press the ‘MIKE 11 Classic’ button 

The simulation will start and in the bottom pane the progress of the simulation as 
shown in Figure 98. 

 

 
Figure 98: Simulation progress dialog 

 

Once the simulation is complete the results of the simulation can be inspected using 
MIKE View. 
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Viewing MIKE 11 results 

The MIKE View program is used to view the results of MIKE 11 . MIKE View offers a 
variety of functions and features for viewing and analyzing simulation results 
produced by the MIKE 11 system. The main presentation features comprise: 

 Color plan plot of the river network 
 Longitudinal profiles 
 Time series plot (Several events can be presented on the same plot). 
 Animation of water level in cross-sections 
 Results from several result-files can be included for comparison. 
 Plot of Q-h relations 
 Animation of user-specified result items (plan plot, longitudinal profiles and 

time series). 
 Zoom facility in all windows 
 Scanned images of background maps can be loaded 
 Hard copy of all plots 

 
A copy of the results file used in this section can be found at  
..\Modelling_Tools_Module\Data\MIKE11. It is called ' VIDA96-3.res11'. 
 

What Are We Going to View 
The river network related to the result file consists of the following elements: 
 

 10 River branches including one main river and several tributaries feeding the 
main stream, 

 8 hydraulic structures of which 7 are regular broad-crested weirs and one is a 
controllable structure with a movable gate controlled by the water-level 
conditions in a gauging point upstream of the movable gate. 

 

We are going to examine the details of the network layout throughout the exercise. 
 

Loading Results 
Start MIKE View by choosing ‘MIKE View’ in the ‘MIKE by DHI 2014’ program group 
as shown in Figure 99. At start-up, MIKE View opens the File Open view. This facility 
makes it possible to navigate through the accessible drives, and you can easily find 
the data directory with your result file. 
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Figure 99: MIKE View start icon 

Examine the possible choices of result file types by clicking on the file types field (See 
Figure 100). Select the ‘MIKE 11 DFS Files (*.Res11)’ option, i.e. the MIKE 11 
Result file. Select the ‘VIDA96-3.Res11’ file from the 
..\Modelling_Tools_Module\Data\MIKE11 folder. 
 

 
Figure 100: MIKE View file types 

The 'Data Load Selection' appears (Figure 101) to give you a chance to discard the 
unnecessary data types or irrelevant simulation periods, or to reduce the time 
resolution of the displayed data. You simply switch ON or OFF certain data types, 
redefine the time interval for loading, and select the appropriate step-loading factor. In 
this case, the result file is fairly small, and you should simply confirm the default 
selection by clicking on the <OK> button. After a short while, the file is loaded and 
MIKE View opens two new windows 
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Figure 101: The Data Load Selection dialog. 

Exploring the MIKE View Screen 
MIKE View has opened two windows (See Figure 102): ' Horizontal Plan window' and 
Plan 'Overview window'  
 

 
Figure 102: MIKE View Screen 

The Horizontal Plan window displays the layout of the river network. If you select the 
Horizontal Plan window it becomes the active window, and the Horizontal Plan 
toolbar appears under the main menu. When you move the cursor within the 
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Horizontal Plan window, the co-ordinates of the current position are displayed in the 
status bar, located in the bottom left corner.  
 

The Overview Plan window contains an outline of the network Horizontal Plan. It 
makes it easier to see where in the network you are while zooming. Try to arrange 
the size and position of the MIKE View windows, until you get them in a desired 
layout. 
 

Zooming 
The zoom function is available in all of the MIKE View graphical presentation 
windows. It is activated by choosing the various zoom tools in the toolbar, or by 
selecting 'Zoom In', 'Zoom Out', 'Zoom Previous' or 'Zoom to Full Extent' in the pop-
up (right click) menu. 
 

If you choose ‘Zoom In’ the cursor changes to a magnifying glass symbol. Move it to 
the location on the plan plot, which should be one of the corners of the zoomed-in 
frame. Then press the mouse button and drag the cursor across the Horizontal Plan. 
The cursor has again changed shape, and the zoom frame rectangle indicates the 
area, which will be included into the zoomed Horizontal Plan window. Continue the 
dragging until you are satisfied with the area included. Release the mouse button, 
and the displayed part of the network Horizontal Plan reduces to the framed area 
only. 
 

The scroll bars of the Horizontal Plan window make it possible to ‘pan’ the zoomed 
frame over the network area. Also, you can drag the zoom frame rectangle in the 
Overview window over the network area to the desired position. 
If you would like to see the whole network again, use <Zoom Out> or <Zoom to Full 
Extent> 
 

Viewing Results 

Selecting result variable and plot type 
Open the he Horizontal Plan Options dialog (Figure 103) by clicking on the  button 
in the toolbar, or by activating the Horizontal Plan local menu (press the right mouse 
button, while in the window). 
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Figure 103: Horizontal Plan Options dialog 

Under the 'Plan Type' tab select one of the result variables (e.g. water levels). Finally, 
you select a mode for the presentation. The results may be viewed as animation, as 
minimum results, as maximum results or as average results. If you select a nimation, 
then the selected variable will be displayed dynamically, as a replay of the simulation 
through time. In this case, choose animation. 
 

When you are finished click <OK>. MIKE View now displays the water levels in the 
Horizontal Plan, corresponding to the start time of the simulation. 
 

Note the date and time indicator in the upper part of the Horizontal Plan (the ‘Clock’). 
The  buttons in the toolbar have been also activated. 
 

Animation in the horizontal plan 

If you click on the  button, the animation will start. You may notice that the time 
elapses in the ‘Clock’, and that the colors on the plan plot are changing, following the 
water level dynamics. 
 

Try the other animation functions: Pause ( ), Stop ( ), Step Forward ( ) 

and Step Backward ( ). The functionality is the same as controlling a tape 
recorder. 
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Flooding and depth 
MIKE 11 computes absolute water levels. However, it may be of particular interest to 
see where flooding occurs in the system. MIKE View can compute the flooding as a 
new variable, which you can view as any other result variable. 
 

In the Main menu choose 'Tools', 'Compute', and then 'Flood'. As soon as you click 
with the mouse, the flooding is computed for the whole system, and added on the list 
of the available variables (in the Options View). 
 

Go back to the Horizontal Plan window and select ‘Flood’ in links under 'Options' of 
menu. Change the plan type to ‘Maximum’ and click OK. Your Horizontal Plan now 
displays the upper envelope of the flooding, which occurred during the simulated 
event. You can also view the dynamics of the flooding, simply by switching to the plot 
type ‘Animation’ and pressing the ‘run’ tool. 
 

Additionally, the actual water depth of a certain location can be of interest. Compute 
also depth in the system. Show these variables as ‘Max’ and as ‘Animation’ as in see 
Figure 104. 
 

 
Figure 104: Maximum Depth for the simulated event. 

Exporting the horizontal plan 
You will often be in a situation, where you want to include some of the MIKE View 
graphs into your report. Start it, and open your report document (or create a new one 
for the case). 
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Return back to MIKE View, adjust the Horizontal Plan to fit your needs in the report, 
and activate the local menu. Simply click  button on the toolbar. Apparently, 
nothing happens, but actually, the content of your Horizontal Plan has been copied to 
the Windows Clipboard. 
 

Switch again to the word processor, position the cursor at the desired location, and 
activate the standard 'Paste' function. The MIKE View plot is pasted into your 
document as a graphical image, which opens the possibilities for resizing and editing. 
This facility works for any graphical window in MIKE View. 
 

Viewing Results in a Longitudinal Profile 
The Horizontal Plan is the working area where items may be selected for all the other 
presentation modes: longitudinal profile, time series, Q-H relations and Cross-section 
animations. 

Selecting a longitudinal profile 
Let’s assume that we want to have a look at the longitudinal profile of the main stream 
starting from upstream point and down to the boundary point where the river has its 
connection with the sea. 

Click on the Longitudinal Profile button in the toolbar  and point with the cursor in 
the vicinity of the upstream point of VIDAA-OVR (ch 108 m). When the cursor 
changes to an arrow, it means that you can start the selection of the longitudinal 
profile. 
 

Click on the branch, and the VIDAA-OVR branch changes color to green. Continue 
the selection by clicking at each branch (or in the direction) along the desired path. 
MIKE View paints your selections bold green. When you arrive to the last branch, 
MIKE View recognizes the end of the path and proposes that the selection is closed 
(See Figure 105).  
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Figure 105: Selection of the branch for a longitudinal profile 

Confirm and choose the type of variable, which you would like to show in the 
longitudinal profile. The default selection is ‘Water Levels’ which is shown in Figure 
106.  
 

  
Figure 106: Longitudinal profile 

If you have selected a wrong branch, ‘deselect’ the last selected branch by 
clicking on the mouse button and pressing the Shift key at the same time (or simply 
press Backspace). 
 

Animating a longitudinal profile 
At first, resize and reposition the Longitudinal Profile window, until you are satisfied 
with the appearance. You can also, as in the Horizontal Plan, zoom-in, zoom-out and 
control various display options by opening the Options View from the local menu. 
 

The animation is started in exactly the same way as in the Horizontal Plan: Just click 
on the  button in the toolbar. 
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Viewing Time Series 
Time series graphs are usually the most relevant graphs for the system analyses. 
MIKE View allows you to see any of the existing time series from the loaded result 
files, to view them in combination with the measured data, and to create time series 
graphs with all possible time series combinations. 
 

Selecting a time series 
Let’s assume that the water level is of our primary interest. Click the  button; in the 
toolbar and select ‘Water Level' as the variable. Select the RES11 file (in case you 
have multiple files added to the current project), and either point the cursor to a point 
in the horizontal plan or press the ‘List’ button to select the Time series location from 
a table.  
 
The cursor changes to an arrow if you are pointing at a point where the data type you 
have selected (i.e.  Water level) is available. After clicking with the mouse, MIKE View 
opens a window with a graph showing the Water level for the actual point as shown in 
Figure 107. 

 
Figure 107: Time series window 

 

Try also to select a Time Series from the Time Series List selection window. 
 

Similarly, as in the longitudinal profile window, you can control the appearance of this 
window in many ways with the right mouse pop-up menu. Try to open the ‘TS 
Settings…’ under ‘Options’ in the pop-up menu where, you can change the 
thickness, colors and other settings for appearance of individual series. 



DSS Modeling tools 

 Page 97 
 

Adding items to a time series graph 
 

You add other time series graph of the same data type as you wish (e.g. Water 
Level). Additionally, you can add data of a different data type to the same windows 
with maximum 2 different data types allowed within a Time Series window. These 
may come from the same result file, from some other loaded result file or from a 
separate DFS0-file. 
 

In this case, you will view the water level in a specific point versus the discharge time 
series from an external DFS0-file at the same point. 
 

Press the Time Series tool button, select ‘Water Level’ and press the List button. In 
the list of calculation points go down to the point ‘VIDAA-OVR 4822.00’ and select 
this point by ticking the check box in the first column. Press the ‘Draw Graph’ button 
to draw the Time Series in a new Windows. After this, open the pop-up menu and 
choose <External TS>, in order to open the External Time Series View. Click on the 
<Load DFS0> button and locate the file; M4234-Q.DFS0 under the 
..\Modelling_Tools_Module\Data\MIKE11 folder. Select the file can then be used for 
comparison with the simulated series. 
 

 
Figure 108: The External Time Series window. 

 
In order to get the time series displayed in the graph, you should select it by clicking 
with the mouse on the time series identifier. Before confirming your selection with 
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<OK>, select ‘Use second y-axis’ from the list. This will cause the Water level and the 
discharge to be shown on different y-axis (See Figure 109). 
 

 
Figure 109: Adding Time series 

Review Questions 

1- List some common applications of the HD module of MIKE 11. 
2- MIKE 11 results are viewed in MIKE zero?  

 True 
 False 
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Answers 

1. Typical applications of MIKE 11 HD module include: 
 Flood forecasting and reservoir operation 
 Simulation of flood control measures 
 Operation of irrigation and surface drainage systems 
 Design of channel systems 
 Tidal and storm surge studies in rivers and estuaries 
2. False (In MIKE View). 
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2.4. MIKE SHE Tutorial 

Introduction 

MIKE SHE delivers truly integrated modeling of groundwater, surface water, recharge 
and evapotranspiration. It includes all the important processes of the hydrological 
cycle for projects require a fully integrated model. 

Short Description of MIKE SHE 

MIKE SHE is a modeling framework, including a range of numerical methods for 
each hydrological process. It has an advanced, conceptual, model independent 
user interface with full water balance accounting for all hydrological processes. 
The hydrological processes and numerical methods can be combined, depending 
on the requirements of your application and the availability of data. All numerical 
engines in MIKE SHE are parallelized to make efficient use of available multi-
core resources. MIKE SHE simulates the following processes:  

OVERLAND FLOW 
MIKE SHE includes both a simple overland flow method for rainfall-runoff 
modeling and a simplified 2D finite difference method for detailed runoff and flood 
modeling. It can simulate detailed flooding based on fine scale topography in a 
coarser numerical grid, as well as detailed two-way exchange with rivers. 

RIVER FLOW 
Channel flow can be simulated using full, 1D hydrodynamics, including operation 
of hydraulic structures, such as gates, pumps and weirs. For larger networks, a 
faster and less data intensive flow routing method is also available. 

UNSATURATED ZONE FLOW 
Vertical unsaturated flow can be simulated using a 1D, finite difference multilayer 
method or a two-layer root zone model based on water balance calculations in 
the unsaturated zone. 

EVAPOTRANSPIRATION 
Rainfall and evapotranspiration are the largest parts of the water balance. In 
MIKE SHE, vegetation based actual evapotranspiration is calculated from 
interception, soil, ponded water, the root zone and groundwater. 
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SNOW 
In cold climates, MIKE SHE converts elevation corrected precipitation to wet and dry 
snow storage. Snow can be converted to surface water using the temperature, 
radiation, and rain-on-snow parameters. 
 
The following are typical applications for which MIKE SHE is often used: 

 Conjunctive use and management of surface water and groundwater 
 Irrigation and drought management 
 Wetland management and restoration 
 Environmental river flows 
 Floodplain management 
 Groundwater induced flooding 
 Land use and climate change impacts on groundwater and surface water 
 Nutrient fate and management 
 Integrated mine water management 

System Requirements 

The recommended minimum system requirements for MIKE SHE are: 
Operating 
systems 

Fully supported operating systems *  
Windows 7 Professional Service Pack 1 (32 and 64 bit), Windows 8 Pro (64 bit) 
and Windows Server 2008 R2 Standard Service Pack 1 (64 bit). Non-
supported but partially tested operating systems ** 
Windows XP Professional Service Pack 3 (32 bit), Windows 8 Pro (32 bit) and 
Windows Server 2012 Standard (64 bit).  

Processor 2.0 GHz Intel Pentium or higher and compatibles, or equivalents 
Memory (RAM) 2 GB (or higher) 
Hard disk 40 GB (or higher) 
Monitor SVGA, resolution 1024x768 in 16 bit colour 
Graphics adapter 64 MB RAM (256 MB RAM or higher recommended), 24 bit true colour 
Media DVD drive compatible with dual-layer DVDs is required for installation 
File system NTFS 
Software 
requirements 

.NET Framework 3.5 SP1 and .NET Framework 4.0 (Full Profile) 

* Fully supported operational systems are systems that have been tested in accordance with MIKE by DHI's Quality 
Assurance procedures and where warranty and software maintenance agreement conditions apply. 

** Non-supported but partially tested operating systems are systems, which are not officially supported by the MIKE 
by DHI software products. These operating systems have only undergone very limited testing for the purpose of 
MIKE by DHI software, but the software and key features are likely to work. Installation of MIKE by DHI software on a 
non-supported operating system is done so at the user's own risk.  

Installation of MIKE SHE 

Installation of MIKE SHE is done as part of Mike by DHIinstallation (For details see 
the DSS installation module). 

How to start MIKE SHE 



DSS Modeling tools 

 Page 102 
 

To start MIKE SHE, go to Start -> Programs -> MIKE by DHI 2014 -> MIKE Zero or 
search for MIKE by DHI 2014 and select ‘MIKE Zero’. Then you can select MIKE 
SHE from within the MIKE Zero Shell. 
 
Starting MIKE SHE without a DHI configured hardware key and valid license files will 
cause the program to run in demo mode. If this happens, a message box will inform 
you during program initialization. When running in demo mode, MIKE SHE supplies 
full access to all editors, computational engines and editing facilities. However, 
restrictions apply to the setups that can actually be executed as a model simulation. 

The MIKE SHE User Interface 

The MIKE SHE user interface is organized by task. In every model application you 
must:  

 Set up the model, 
 Process the data 
 Run the model, and view the results. 

The above three tasks are carried until you obtain the results that you want from the 
model. When you create or open a MIKE SHE model, you will find yourself in the 
Setup Tab of the MIKE SHE user interface (See Figure 110). 

 
Figure 110: MIKE SHE user interface 

The Setup section is divided into three sections, the data tree, a context sensitive 
pane and a validation area.  
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The data tree is dynamic and changes with how you set up your model. It provides 
an overview of all of the relevant data in your model. The data tree is organized 
vertically, in the sense that if you work your way down the tree, by the time you come 
to the bottom you are ready to run your model. The following sections are included in 
the tree:  

 Display - display of map overlays 
 Simulation Specification - control and selection of water movement engines 
 Water Quality Simulation Specification - control and selection of water quality 

engines 
 Species - specification of species for water quality simulations 
 Water Quality Sorption and Decay  
 Model Domain and Grid - definition of model extent and grid 
 Subcatchments - definition of catchment boundaries for lumped parameter 

water movement engines 
 Topography - specification of land surface elevation 
 Climate - specification and extent of climate measurements, such as 

precipitation and evapotranspiration 
 Land Use - specification of vegetation and irrigation 
 Rivers and Lakes - link to MIKE 11 channel flow model 
 Overland Flow - specification of 2D overland sheet flow parameters for both 

water movement and water quality 
 Unsaturated Zone - specification of 1D unsaturated zone columns  
 Groundwater table for lower UZ boundary - specification of static lower 

boundary condition for unsaturated flow, if saturated zone not included 
 Saturated Zone - specification of 3D saturated zone parameters for both 

water movement and water quality 
 Sources - location and extent of solute sources for water quality simulation 
 Storing of Results - output selection for calibration time series and gridded 

data 
 Extra Parameters - extra input data for model options not yet available in the 

data tree 
 
The context sensitive pane on the right allows you to input the required data 
associated with your current location in the data tree. The dialogues vary with the 
type of data, which can be any combination of static and dynamic data, as well as 
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spatial and non-spatial data. In the case of spatial and time varying data, the actual 
data is not input to the GUI. Rather, a file name must be specified and the link to the 
file is stored in the GUI. Furthermore, the distribution of the data in time and space 
need not correspond between the various entries. For example, rainfall data may be 
entered as hourly values and pumping rates as weekly values, while the model may 
be run with daily time steps.  
 
The validation area at the bottom of the dialogue provides you with immediate 
feedback on the validity of the data that you have input.  

Setting up a MIKE SHE simulation 

In this section, you will setup a simple MIKE SHE simulation. Data for this simulation 
can be found at ..\Modelling_Tools_Module\Data\MIKESHE folder. 
 
you will create a MIKE SHE setup from scratch and include an overland flow model. 
The required specifications include: 

 Definition of the model domain and grid which will be used as the 
computational mesh 

 Definition of surface topography  and roughness 
 Definition of simulation parameters such as time-step and numerical control 

parameters. 
 Specification of rainfall. 

Create a new MIKE SHE setup file (.SHE). 

 Start MIKE Zero and create a new MIKE SHE file (.SHE).  
 File -> New -> File -> MIKE SHE -> Flow Model as in Figure 111. 

 

 
Figure 111: Creating a new MIKE SHE flow model  
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Simulation Specifications 
In the MIKE SHE explorer, browse to 'Simulation specification' and include only 
Overland flow in the simulation and use the 'Finite difference' solver (See Figure 
112). 

 
Figure 112: Simulation specifications 

Simulation title: you may specify a simulation title and a short description of the 
setup. This is however not required. 
 
Simulation period (Figure 113):  
Start date : 1st January 2000 
End date: 30th March 2000 
 
You can change these settings at any time. It is however required that all time 
varying data (e.g. rainfall) is available within the simulation period. We will come back 
to “Time step control” and “OL Computational Control Parameters” later in the 
exercise. 

 
Figure 113: Simulation period 
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Define Model Domain and grid 
In the MIKE SHE explorer, click the “Model domain and Grid” node (Figure 114). 

 Select “Catchment defined by shape file” 
 Browse to ..\Modelling_Tools_Module\Data\MIKESHE\gis\Catchment folder 

and select the file “VaiparBasinBound_UTM.shp” (here the item is not 
important. Select e.g. ID) and click OK then click OK again to accept the units 
(i.e. meters). 

 
Figure 114: Defining model domain  

Change the grid resolution 
The equidistant grid defined here will be used by MIKE SHE in the numerical 
solution (computational mesh) 
 

 Define the mesh as shown in Figure 115. 
 

 
Figure 115: Defining the grid resolution 

Include spatial overlays 
In the MIKE SHE explorer, click the 'Display' node. Use 'default map display based 
on the model domain' (See Figure 116) as follows:  
 

 Select the 'Foreground' Node' 

 Insert a new row with type 'shape' using the  button.  
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 Then click the “shape:Unknown” node in the explorer, by expanding the 
‘Foreground’ node (See Figure 117). 

 Browse to ..\Modelling_Tools_Module\Data\MIKESHE\gis\Catchment and 
select the file 'VaiparBasinBound_UTM.shp'. Before pressing OK pick 
'Basin_Name' from the item list. 

 In a similar manner Insert a new row with type 'shape' using the  button 
but this time select 'River' and add a MIKE11 network file to the display. Use 
the 'Vaippar river - simplified.nwk11' file located in the  
..\Modelling_Tools_Module\Data\MIKESHE\MIKE11\Network folder. In the list 
of overlays select “River” and then “user defined” and browse to the above 
file. 

 Go back to the “Display node” to see the overlays. You may try to change the 
appearance of the spatial overlays (e.g. colours, lines). It could look 
something like Figure 118. 

 These overlays will be displayed on all map displays in MIKE SHE. 
 

 
Figure 116: Defining map display 

 

 
Figure 117: Adding a shape file 
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Figure 118: Map display with a catchment and river network 

Save the MIKE SHE setup 
 File  -> Save As 
 Browse to the ..\Modelling_Tools_Module\Data\MIKESHE folder. 
 Name the file “EX1” (the suffix .SHE) will be added automatically. 

The full MIKE SHE setup is saved in a .SHE document.  

Define Surface topography 
 
When defining elevation data (such as surface topography), MIKE SHE allows the 
user to specify a uniform value (e.g. 10 m) which will be used throughout the model 
domain or – which you would typically want – distributed values supporting different 
file formats (dfs2, shp, and txt). In this exercise we will use a dfs2 file (Figure 119).  
 

 Browse to the “Topography” node 
 Select “Grid file (.dfs2)” 

Browse and select the file ' vaipardem_no_gaps.dfs2' from the 
..\Training_HowTos\Modelling_Tools_Module\Data\MIKESHE\maps\DEM 
folder. 

 
Figure 119: Selecting the dfs2 option for topography 

Define climate data 
 

 Select the 'climate' node and then 'Precipitation rate' (See Figure 120) 
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 Use uniform spatial distribution 
 Use timevarying (dfs0) for temporal distribution. 
 Select a rainfall time-series by browsing to the 

..\Modelling_Tools_Module\Data\MIKESHE\timeseries\Climate folder and 
selecting  'VaiparRF.dfs0'. The file contains multiple rainfall time-series. 
Select the item named 'Ettayapuram' 

 Leave the “net rainfall factor” at 1.0 which means that all rainfall is applied 
directly on the ground surface (the net rainfall factor is simply multiplied on 
the rainfall rate). 

 
Figure 120: Climate data options 

Define Overland Flow Parameters 
 Browse to the 'Overland Flow' node (See Figure 121) 
 Define uniform manning number = 5 
 Detention storage = 0 
 Initial water depth = 0 

 
Figure 121: Overland flow parameters 

Storing of Results 
 Browse to 'Storing of Results' 
 Disable 'Storing of Water balance' 
 Define storage time-step for 'Overland flow' and “Precipitation” data to 24 

hours as in Figure 122. 
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Figure 122: Storing result options (partial screenshot) 

 Select 'Grid series outputs' node and Select (check) “Precipitation rate” and 
“Depth of overland water” as in Figure 123 

 
Figure 123: Grid series output 

Run the Pre-processor (PP) 
MIKE SHE’s engine is divided in two separate components, a Pre-processor (PP) 
and a Water Movement simulation engine (WM).  
 
The pre-processor (PP) reads all input data from the .SHE file and prepare all input 
data so they are available in the defined model grid.  Whenever the setup is changed 
the PP has to be executed before a water movement simulation can be executed. 
 

 Save the setup by pressing the  button in the toolbar.  

 Run the pre-processor by pressing the  button in the toolbar (click OK to 
dismiss the 'Launch Settings' dialog and then simulation starts. 

Inspect Pre-processed data 
 Click the 'Processed data' tab (See Figure 124) 
 Browse the 'Processed data' tree and inspect the processed data. 
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 The explorer gives you a quick view on the pre-processed data 
 Try selecting the 'surface topography' and then click the 'View button' (See 

Figure 125) 
 This brings you to a 2D editor which gives you a more detailed view if needed 

(and which can be used for editing 2D data). 
 Experiment with the 2D editor: 
 Select different items from the pull-down menu (right side of the tool-strip) 
 Double click in the map (What do you notice?). 

 

 
Figure 124: Processed data tab 

 

 
Figure 125: Surface topography processed data 

Computational Control 
 Browse to OL Computational control under the setup page (See Figure 126) 
 Select the Explicit solver 
 Define settings as illustrated to the below 
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Figure 126: Setting the computational control parameters 

Run the water movement simulation 
 Press the  button 
 Watch the 'Simulation' tab in the lower pane. 

Inspect Results 
 Press the “Results” tab (See Figure 127) 
 Press “View result” – start with precipitation 

 
Figure 127: Results tab 

Result Viewing 
 Press the “Results” tab. This will start a Result Viewer 
 Push the “play” button in the top toolbar (See Figure 128). 
 Select the “Time series” button (See Figure 129). 
 Double click on a location on the map (What do you notice). 
 Do the same for overland flow (close the result viewer and press “View” on 

overland depth). 
  

 
Figure 128: Play button 
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Figure 129: Time series button 

File structure 
When running MIKE SHE PP a new folder is created under the folder where the 
.SHE document is placed. The folder will get the same name as the .SHE document 
appended with “- Result Files”. In this “case EX1.she - Result Files”. The folder also 
contains the pre-proessed data. All gridded data are stored in a dfs2 document and 
may be inspected. Input parameters and other data types are stored in the pfs file. 
  

Review Questions 

1. List some common applications of the of MIKE SHE. 
2. MIKE 11 results are viewed in MIKE View?  

 True 
 False 
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Answers 

1. The following are typical applications for which MIKE SHE is often used: 
 Conjunctive use and management of surface water and groundwater 
 Irrigation and drought management 
 Wetland management and restoration 
 Environmental river flows 
 Floodplain management 
 Groundwater induced flooding 
 Land use and climate change impacts on groundwater and surface water 
 Nutrient fate and management 
 Integrated mine water management  

2. False (In Mike Zero) 
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